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Welcome

Apple Learning Series: Secondary Language Arts & Social Studies provides you with

materials to help you easily integrate technology into your classroom. This Getting

Started Guide describes the contents of this kit, what you need to do before you use

the software, and how to install and begin using the software.

Secondary Language Arts & Social Studies contains the following items:

m Secondary Language Arts & Social Studies CD software case

m Resources on the Secondary Language Arts & Social Studies Web site

m Quick Start card

Secondary Language Arts & Social Studies 
CD Software Case

The CD software case contains all of the software for Secondary Language Arts &

Social Studies. Most products include electronic documentation on the CD, such as

user’s manuals or teacher’s guides.

Web Site Contents

The Secondary Language Arts & Social Studies Web site includes the following

components:

Curriculum

The Web site includes student projects for both the middle school and high school

levels. Each project provides ideas for integrating the kit software in your classroom.

You can view the student projects online or download and print them from the 

Web site.

Read the middle school and high school Curriculum Overviews on the Web site for

detailed information about the contents and structure of the student projects and the

other curriculum resources.
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Step-by-Step Instructions

Step-by-step instructions for tasks that involve the kit software and Apple technology

are included on the Web site. These detailed instructions are designed to help your

students work independently to complete software-related activities. You can

download and print the files using Adobe™ Acrobat™ Reader. (See “Installing Acrobat

Reader,” later in this guide, for instructions on using this program.) After you print

the Step-by-Step Cards, you can laminate them for durability and keep them near the

computer.

Resources

Electronic templates are provided to help you and your students complete some of

the activities in the projects. These templates can be downloaded from the Web site.

You can use these files as they are or customize them for your classroom needs. The

Resources area of the Web site also includes relevant QuickTime movies and

documents that will help you use the templates and projects.

Curriculum Standards

The Secondary Language Arts & Social Studies Web site contains correlations

information that specifies how the software and student projects align to curriculum

standards. You can search for correlation information by grade level, subject area,

topic, and by select states.

Apple Learning Professional Development Online Course

Secondary Language Arts & Social Studies includes an online course that is designed

to help you learn how to use the kit software to enhance the curriculum in your

classroom. You can access this course from the Secondary Language Arts & Social

Studies Web site by clicking the Professional Development button.

The course introduces each of the software products, presents a brief demonstration

of an aspect of the software, and describes how the software can be applied in your

classroom.

Community

This area of the Web site includes forums where you can discuss the Secondary

Language Arts & Social Studies kit and its online course; additional student projects,

submitted by other teachers, that use the kit software; and teachers’ reviews of the

software. You can also access the extensive resources of Apple Learning Interchange

(ALI), the Apple online community for educators. ALI offers forums, chat rooms,

lesson plans submitted by teachers, special events, and other resources.
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First Steps

Several preliminary steps need to be taken before you begin using the software in

Secondary Language Arts & Social Studies. These steps are described in “Before You

Use the Software,” below. You should also become familiar with Adobe Acrobat

Reader, the program you will use to read most of the electronic documentation in

this kit and many of the files you download from the Secondary Language Arts &

Social Studies Web site. See “Using Acrobat Reader,” later in this section, for detailed

instructions about using this program.

Before You Use the Software

Before you begin to use the software, you need to select a printer and make sure that

the correct versions of QuickTime and Acrobat Reader are installed.

Note:  If you are using the student projects with an iBook or Power Mac G4

computer, you will need a compatible external microphone (available separately) to

complete the activities that involve recording sound.

Selecting a Printer

Some programs in the kit require you to have a printer selected, even if your

computer is not connected to a printer. If you have not already selected a printer,

follow these steps to do so:

1 Open the Apple (K) menu and choose Chooser.

2 In the upper-left section of the Chooser window, click to select the printer driver 

that corresponds to the kind of printer you want to use.

Note:  If your computer is not connected to a printer, select the LaserWriter 8 icon,

then click the close box to close the Chooser. You don’t have to do steps 3 and 4.

3 In the upper-right section of the window, do one of the following:

m If you are connected to a network, click to select the name of the printer you 

want to print to.

m If you are not connected to a network, click to select the printer port or modem

port, whichever port your printer is connected to.

4 Click the close box to close the Chooser window.
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For more information on setting printer options, see the manual that came with

your printer.

Installing QuickTime

To use some of the software in the kit, you need QuickTime 4.0 or later installed on

your computer. To install the latest version of QuickTime, go to the Apple Web site at

www.apple.com/quicktime/ and follow the onscreen instructions. To check the

version of QuickTime that is installed on your computer, choose Control Panels from

the Apple menu, then choose Extensions Manager from the submenu. Scroll to

QuickTime in the list below Extensions. The version number is displayed.

Installing Acrobat Reader

Most of the electronic documentation included on the software CDs and many of the

files you download from the kit’s Web pages are in Adobe Acrobat format, also called

“PDF” format. To view and print these files, you need the Adobe Acrobat Reader

program. On some computers, Acrobat Reader is preinstalled in the Applications

folder.

If you purchased Secondary Language Arts & Social Studies without a computer, you

need to check to see if the latest version of Acrobat Reader is installed on your

computer. You can find out the version number of the Acrobat Reader program by

selecting the Acrobat Reader program icon, then choosing Get Info from the File

menu. The version number is displayed. You can find out the latest version number

available by going to the Adobe Web site at www.adobe.com. If you do not have the

latest version already installed on your computer, you can download the new Installer

program for free from the Adobe Web site.

Using Acrobat Reader

With Acrobat Reader, you can easily move around the documentation, search for

specific words or phrases, change the size of a page, and print any pages you want to

have as hard copy.

Moving Through a Document

You can move through a document in a number of different ways:

m To go to the next page, click the Next Page button ( ) on the toolbar.

m To return to the previous page, click the Previous Page button ( ).

m To return to the first page, click the First Page button ( ).

m To go to a specific page, click the page number box on the status bar at the

bottom of the main window, type the page number, and click OK. 

m To search for a specific word, phrase, or activity, click the binoculars button ( )

on the toolbar, type the information you are searching for, and click Find.

For more information about moving around in Acrobat Reader documents, see

“Navigating pages” in the “Viewing PDF documents” section of the Acrobat Reader

electronic help system.
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Changing the Size of a Page

To magnify or reduce the size of a page, click the box with the magnifying glass ( )

on the status bar at the bottom of the page, then select a magnification level. Refer to

“Viewing documents” in the “Viewing PDF documents” section of the Acrobat Reader

electronic help system for detailed information on other page display tools and

options.

Printing Pages

You can print any pages of a PDF document while in the Acrobat Reader program.

To print specific pages using most printers, follow these steps:

1 Choose Print from the File menu.

2 Enter the page numbers as they appear at the bottom of the Acrobat Reader window.

These numbers may differ from the numbers that actually appear on the document

itself.

3 Click Print.

Using the Acrobat Reader Help System

For more information about using Acrobat Reader, see the program’s electronic help

system. To use the help system, choose Reader Online Guide from the Help menu,

then select the topic you want. Click “How to use this online guide” from the list at

the left of the main page to learn more about using the help system.

6 Secondary Language Arts & Social Studies Getting Started Guide



Software Descriptions 
and Installation Instructions

The CD software case contains all of the software titles included with Secondary

Language Arts & Social Studies.

The following sections provide a brief description of each software product,

information on installing and opening the program, and ways to learn more about 

it. Use these instructions, rather than the instructions that may be in the product’s

electronic manual or Read Me file. For most of the software products, you’ll find a

technical support phone number. (The phone numbers listed in this section were

current at the time the guide was written. However, this information is subject to

change.)

Note:  Do not install any version of QuickTime or Acrobat Reader that might be

included on a product’s CD. The product CDs sometimes include older versions of

QuickTime or Acrobat Reader. If you install an older version of QuickTime you may

have problems using the software; an older version of Acrobat Reader might prevent

you from opening electronic documentation or files you download from the

Secondary Language Arts & Social Studies Web site.

If you install an older version of QuickTime or Acrobat Reader by mistake, you can

easily reinstall the current version. To install the latest version of QuickTime, go to

the Apple Web site at www.apple.com/quicktime/ and follow the onscreen

instructions. (After installation, you should make sure that the older version of

QuickTime is no longer on your hard disk.) To install the latest version of Acrobat

Reader, go to the Adobe Web site at www.adobe.com and follow those instructions.
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American History Online From ABC-CLIO

This online resource provides comprehensive reference materials and other learning

tools related to U.S. History. On the Web site are more than 10,000 items, including

primary documents, quotations, biographies, critical essays, video clips, photographs,

political cartoons, audio excerpts, and maps. Students can print materials they find or

use them in other programs.

The Web site also includes interactive topic explorations (on such topics as the

American Revolution and the West), daily updated news features, discussion

questions, a glossary, content correlations to national history and geography

standards, and a test bank.

Note:  Your subscription to American History Online is valid for one year from the

date of activation.

Activating American History Online

1 Open your Web browser and go to http://www.abc-clio.com/apple

2 Follow the onscreen instructions to register and begin using your subscription.

In addition to other information, you will be asked to enter your registration key

which is on the American History Online information card in the CD sleeve in the CD

software case. You will also be asked to create an administrator login name and

password that you will use whenever you visit the site. It’s a good idea to write this

information in the space provided on the card so you will have it readily available.

When prompted, enter a default class login name and password for your students to

use. ( You can add additional class login names and passwords once you have

activated your subscription.)

3 When you’re done, click the link to www.americanhistory.abc-clio.com to start using

your subscription right away.

Using American History Online

1 Once you have activated your subscription, go to www.americanhistory.abc-clio.com

to sign in.

2 When you sign in, you need to enter your administrator login name and password;

your students need to enter their class login name and password.

3 Click the American History button to go to the home page or click the Administrator

button to go directly to the Administration page (you need to have entered the

administrator login name and password to access this page).

4 From the home page, you can perform a keyword search; view the living history

article, this day in history, and other feature stories; and access student section

elements, such as teacher announcements, the syllabus, and “Student Voices,”

featuring the perspective of students from around the United States.
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5 From the Administration page, you can set up additional class login names and

passwords, and create a customized syllabus and other information to add to the

Student section. The Administration section also provides a user’s guide, suggested

discussion questions (with answers), handouts, tests, and links to additional

resources.

Learning More About American History Online 

You can access and print a user’s guide to American History Online from the

Administration page. The user’s guide includes instructions about setting up

individual class accounts and customizing documents for use in the Student section.

The service and support telephone number for American History Online is 

800-368-6868, extension 169.

Secondary Language Arts & Social Studies Getting Started Guide 9



Decisions, Decisions: Colonization 
From Tom Snyder Productions

In this CD from the Decisions, Decisions series, students work in teams to role-play a

president of the United States who must decide whether to allow a private company

to set up a U.S. colony in space to search for fuel deposits. Because the issues are the

same as those faced by the original colonizers of the United States, students study the

history of U.S. colonization and apply what they learn to the current situation.

Students follow a five-step model for critical thinking and decision making to gather

and analyze information, discuss and debate their choices, take action, and evaluate

their decision.

Using Decisions, Decisions: Colonization

You use Decisions, Decisions: Colonization directly from the CD.

1 Insert the Decisions, Decisions: Colonization CD into the CD or DVD drive.

2 Double-click the Decisions, Decisions CD icon, if necessary.

3 Double-click the Colonization icon to open the program.

4 You can choose Overview from the Decisions, Decisions: Colonization main menu to

see a narrated introduction of how Decisions, Decisions titles are used in the

classroom.

Learning More About Decisions, Decisions: Colonization

A teacher’s guide is included in the Teacher’s Guide folder. Double-click the

Colonization TG.pdf file icon to open the teacher’s guide.

Files for four student booklets (“briefing books” for the president from an economist,

an historian, the Secretary of Commerce, and the Secretary of Space Exploration) are

included on the CD in the Student Books folder. You can print these booklets and

distribute them to students, or you can order the booklets in printed form by calling

800-342-0236.

Decisions, Decisions: Colonization also includes an electronic help system. 

1 Choose Decisions Help from the Help menu.

2 Click to select Topics, Index, or Look For to find the information you want.

3 When you’re done using the help system, click the help window close box.

You can also see information about the current screen by clicking the Guide button

in the lower-right corner of the screen.

The service and support number for Decisions, Decisions: Colonization is 

800-342-0236, extension 253.
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Get A Clue From Lyceum Communications

Get A Clue is vocabulary development software that uses inductive reasoning and

other critical thinking skills to help students gain an understanding of words. Two

versions of Get A Clue are included on this CD, both of which use multimedia to

engage students’ interest. The Junior Mastery version includes 150 target words

appropriate for students in grades 5 to 8. The Mastery Edition includes 300 target

words designed for students in grades 9 to 12. The words are representative of those

found on the PSAT/SAT or similar state or national achievement exams. Students can

work through the program on their own or teachers can assign specific levels or

categories of words. The program tracks student progress.

Installing Get A Clue

1 Insert the Get A Clue CD into the CD or DVD drive.

2 Double-click the Get A Clue! CD icon, if necessary.

3 Depending on the version you want to install, double-click the Installer Mastery

Edition icon or the Install Junior Mastery icon.

4 In the dialog box that appears, click Install.

5 When you see a message that installation was successful, click Quit.

Using Get A Clue—Junior Mastery

1 Open the Get A Clue—Junior Mastery folder on your hard disk.

2 Double-click the Get A Clue Jr Mastery 2.0 icon to open the program.

3 Click Begin on the main screen.

The first time you use the program, you need to sign in and select a password.

4 Type a user name and a password, then click OK.

Using Get A Clue—Mastery Edition

1 Open the Get A Clue—Mastery Edition folder on your hard disk.

2 Double-click the Get A Clue—Mastery 2.0 icon to open the program.

3 Click Log In on the main screen.

The first time you use the program, you need to sign in and select a password.

4 Type a user name and a password, then click OK.
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Learning More About Get A Clue

With both versions, click User Instructions on the main screen to see help

information about using the program. Click Begin when you’re ready to use the

program.

A teacher’s guide for each version of the program is included on the CD. The CD also

includes supplemental materials for each version, such as word lists and quizzes.

The service and support telephone number for Get A Clue is 888-321-2583.

12 Secondary Language Arts & Social Studies Getting Started Guide



In My Own Voice: Multicultural Poets on Identity 
From Sunburst Technology

This CD examines the subject of identity from a variety of cultural perspectives by

looking at 27 poems written by 9 contemporary American poets. The CD includes

audio recordings of the poets introducing and reading their poems, annotations to

the poems, illustrations, and music. Students can write and record their own poems

with the multimedia word-processing tool and can take notes from anywhere in the

CD with the notepad feature.

Using In My Own Voice

You use In My Own Voice directly from the CD.

1 Insert the In My Own Voice CD into the CD or DVD drive.

2 Double-click the In My Own Voice CD icon, if necessary.

3 Double-click the In My Own Voice icon to open the program.

A dialog box appears asking you to open or create a new notepad file.

4 Click New.

5 In the dialog box that appears, type a name for your notepad file and select a location

on your computer where you want to save it. Click Save.

The program’s main screen appears.

Learning More About In My Own Voice

In My Own Voice includes a teacher’s guide on the CD, and an electronic help

system. To use the help system, follow these steps:

1 Click the Help button on the right side of the screen.

2 Click a topic in the contents list to see more information about that subject.

3 Use the red arrows on the right side of the help window to scroll through the text.

4 Click the help window close box when you’re done using the help system.

The service and support telephone number for In My Own Voice is 800-338-3457,

extension 2410.
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Inspiration From Inspiration Software

Inspiration is a versatile program that can be used in all areas of the curriculum. The

program’s diagram features offer you a symbols library and drawing tools to create

“visual maps” of ideas and concepts. You can use the comprehensive outlining

environment to plan and organize reports, Web sites, multimedia presentations, and

other projects. Examples and templates included with the program illustrate a variety

of ways you can use Inspiration in the classroom.

Installing Inspiration

1 Insert the Inspiration CD into the CD or DVD drive.

2 Double-click the Inspiration 6 Install icon in the CD window, then click Continue in

the opening screen.

3 Click Install in the dialog box that appears.

4 When you see a message stating that installation was successful, click Quit. 

5 In the dialog box that appears, type your name, school, and the serial number. The

serial number is on a sticker on the CD sleeve in the CD software case. Click OK.

6 Select how you want to register the product in the next dialog box.

Note:  Do not install the version of Acrobat Reader that is included in the Manual

folder on the CD. A later version of this program is already installed on your

computer.

Using Inspiration

1 Open the Inspiration 6 folder on your hard disk, if necessary.

2 Click Close in the “Tip of the Day” window when you are done reading it, or click

Next to see more tips.

Learning More About Inspiration

Inspiration includes an electronic getting started guide and user’s manual, located in

the Manual folder on the CD. 

Inspiration also includes an electronic help system. To use the help system, choose

Inspiration Help from the Help menu, then click Help Topics. Choose Quit from the

Help menu when you’re done using the help system.

The service and support telephone number for Inspiration is 800-877-4292.
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mPOWER From Tom Snyder Productions

With mPOWER, you can easily create interactive multimedia presentations that

incorporate text, images, video, and sound. The slides in a presentation can include

hot buttons, transitions, special effects, and hyperlinks. The program’s interface is

based on an ATM screen and features a title area, object window, and buttons for

different actions.

Installing mPOWER

1 Insert the mPOWER CD into the CD or DVD drive.

2 Double-click the mPOWER 4.0 CD icon, if necessary.

3 Double-click the mPOWER 4.0 Installer icon, then click Install in the dialog box that

appears.

4 Click Continue when you see a message about restarting your computer after

installation.

5 When you see a message stating that installation was successful, click Restart.

Using mPOWER

1 Open the mPOWER 4.0 Folder on your hard disk if it’s not already open.

2 Double-click the mPOWER 4.0 icon to open the program.

3 Click New Presentation or Open Presentation.

Learning More About mPOWER

mPOWER includes a user’s guide and a tutorial on the CD, and an electronic help

system. To use the help system, follow these steps:

1 Click the Help button.

2 Click a topic in the mPOWER Help window or in the Help Topics window, then click

Show.

3 When you’ve finished using the help system, click Done.

The service and support telephone number for mPOWER is 800-342-0236.
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Romeo & Juliet From Bride Media International

This CD brings Shakespeare’s Romeo and Juliet to life by combining video

performances of selected scenes, expert commentaries, original and paraphrased

text, and a wealth of other information. All of the play’s text is presented, with a

video summary of each scene. Students can choose to see each page of text

paraphrased or click words to see their modern English equivalent. The onscreen

text also identifies foreshadowing, puns, and other elements. 

Video presentations by a Shakespeare expert and an actor are illustrated with clips of

scenes and cover topics such as humor in Shakespeare, the description of nature in

the play, and how the play deals with the conflict between the feuding families.

Installing Romeo & Juliet

1 Insert the Romeo & Juliet CD into the CD or DVD drive.

2 Double-click the R&J CD icon.

3 Double-click the R&J 1.2.1 Installer icon, then click Continue in the Welcome

window.

4 Click Install in the dialog box that appears.

5 When you see a message stating that installation was successful, click Quit.

Using Romeo & Juliet

1 Open the Bride Media folder on your hard disk if it’s not already open.

2 Double-click the “start R&J” icon to open the program.

Note:  It’s a good idea to click to see the Help Screen the first time you open the

program. An introduction to using the program is presented. You can then click the

Main button when it appears to open the program.

Learning More About Romeo & Juliet

A teacher’s guide for Romeo & Juliet is included in the Bride Media folder on your

computer as well as on the CD.

To see and hear the help information, click the Help button on the main menu or

click to see the Help Screen from the opening screen.

The service and support telephone number for Romeo & Juliet is 781-329-7660.
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Talking Walls From Edmark

This CD, which is based on the book by Margy Burns Knight, explores culture and

history using 15 walls from around the world. These walls include the Great Wall of

China, the Vietnam Veterans Memorial in Washington, D.C., Lascaux Cave in France,

and the Diego Rivera murals in Mexico. Students can choose to read or have the text

from the book read to them and can also explore related information for each wall,

such as archival footage from CNN, original videos, timelines, graphics, and more.

The software provides Internet links to additional resources as well as a glossary and

a note-taker.

Installing Talking Walls

1 Insert the Talking Walls CD into the CD or DVD drive.

2 Double-click the Talking Walls CD icon, if necessary.

3 Double-click the Install Talking Walls icon, then click Continue in the title screen.

4 Click Install in the next dialog box.

5 Click Install in the next dialog box to install the files on your computer.

6 Click OK when you see a message that installation was successful.

A Read Me document appears.

7 Click the Read Me document’s close box when you’re done reviewing it.

You’ll still need the CD to use Talking Walls because not all of the files have been

installed on your computer.

Using Talking Walls

1 Make sure the CD is inserted in the CD or DVD drive.

2 Double-click the Talking Walls icon located in the Talking Walls Folder on your hard

disk.

3 Type your name in the screen that appears, then click OK.

4 Click Talking Walls to begin reading the book.

Learning More About Talking Walls

The Talking Walls CD includes a user’s guide. The program also includes an online

help system. Click the Help button to see information about the features of the

current screen. Click Read to have the help information read to you. Click Close

when you’re done.

The service and support telephone number for Talking Walls is 425-556-8480.
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TimeLiner Collection From Tom Snyder Productions

TimeLiner is a tool that lets you create and modify different kinds of timelines. You

can chronicle broad topics, such as historical events and geological formations, or

examine milestones in students’ lives with daily, weekly, and yearlong timelines. With

this version of TimeLiner, movies, sounds, and Web links can be added to timeline

events and a timeline can be presented as a multimedia slideshow. TimeLiner also

includes collections of completed timelines, among which are American History,

Women in History, Pre- and Ancient History, African-American History, and History of

Exploration.

Installing TimeLiner Collection

You can install TimeLiner on your computer or you can use it from the CD. To install

it on your computer, follow these steps:

1 Insert the TimeLiner Collection CD into the CD or DVD drive.

2 Double-click the TimeLiner 5.0 CD icon, if necessary.

3 Drag the TimeLiner 5.0 folder to your hard disk icon.

Whether you install TimeLiner on your computer or want to use it from the CD, you

need to install certain help system files to be able to search the help system for

specific items. To install these files, follow these steps:

1 Open the TimeLiner 5.0 folder on your computer (if you installed it there) or on 

the CD.

2 Double-click the Help Installer icon. The help system files are installed on your 

computer.

3 Click Quit when you see a message that installation was successful.

Using TimeLiner Collection

1 Open the TimeLiner 5.0 folder located on your computer or on the CD.

2 Double-click the TimeLiner 5.0 icon to open the program.

3 From the opening screen, click Open to open an existing timeline or New to create a

new one.
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Learning More About TimeLiner Collection

An electronic teacher’s guide and a getting started guide are included in the

Documentation folder located in the TimeLiner 5.0 folder. The teacher’s guide

includes an introductory tutorial, called a “walkthrough,” as well as student project

worksheets and suggested student activities. The timeline collections are located in

the “Ready Made Time Lines ƒ” folder in the TimeLiner 5.0 folder. The TimeLiner 5.0

folder also includes sample timelines and a large selection of clip art that you can use

to illustrate timelines.

TimeLiner also includes an electronic help system. Click the ? icon on a screen or

choose HTML Help from the Help menu to open the help system. Click to select a

topic. To search for a specific term, type the term and click Search. When you’re

done using the help system, click the help window close box.

The service and support telephone number for TimeLiner is 800-342-0236, 

extension 255.
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World Book 2001 From World Book, Inc.

This two-CD set combines the text and illustrations of the World Book Encyclopedia

with the impact of video, sound, animation, and Internet resources. Students can

easily access specific information with the program’s search tools and can then use

the highlighting and sticky notes features to keep track of what they find.

World Book 2001 includes an atlas, a dictionary, a Homework Wizard to help students

with assignments such as reports and timelines, and Internet links to additional

resources and updated information. This edition also includes “Surf the Millennium,”

a collection of imaginary Web sites from the last 1,000 years.

Installing World Book 2001

1 Insert the World Book Disk 1 CD into the CD or DVD drive.

2 Double-click the WB2001 Disk CD icon, if necessary.

3 Double-click the World Book 2001 Installer icon, then click Continue in the opening

screen.

4 Click Continue in the Read Me screen. (Information is included here about using

World Book 2001 with the Multiple Users environment.)

5 Click Install in the next dialog box.

6 Click Install in the next dialog box to install the program in a folder called “World

Book folder” on your computer.

7 Click OK when you see a message stating that installation was successful.

You’ll still need the CDs to use World Book 2001 because not all of the files from the

CDs have been installed on your computer.

Using World Book 2001

1 Make sure World Book Disk 1 is still in the CD or DVD drive.

2 Open the World Book folder on your computer, if it’s not already open.

3 Double-click the World Book icon to open the program.

4 Click Agree in the license agreement window that appears the first time you open the

program.

5 Make a selection from the main menu screen.
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Learning More About World Book 2001

A user’s guide is included on the CD. Double-click the World Book–Mac Users Guide

icon in the CD window to open this document.

World Book 2001 also includes an electronic help system.

1 Choose Help Topics from the Help menu to open the help system.

2 Click Topics, Index, or Find to locate information on the subject you want.

3 When you’re done using the help system, click the help window close box.

The service and support telephone number for World Book 2001 is 888-732-6564.
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The Writing Trek—Grades 8-10 
From Sunburst Technology

The Writing Trek provides interactive language arts projects and writing skills lessons

that are designed to build writing competence and creativity. Students travel around

a fantasy village and can enter buildings which contain student projects, a notebook

that guides them through the projects, and a place to save their work. The projects

encompass many different types of writing, including science fiction, news stories,

poetry, and speeches. Students also explore the general concepts involved in each

genre, and can use five writing resources, such as an almanac and a rhyming

dictionary.

Installing The Writing Trek

1 Insert The Writing Trek CD into the CD or DVD drive.

2 Double-click the Trek 8-10 I CD icon, if necessary.

3 Double-click the Writing Trek 8-10 I Install icon, then click Continue in the title

screen.

4 Click Install in the dialog box that appears.

5 When you see a message stating that installation was successful, click Quit.

You’ll still need the CD to use The Writing Trek because not all of the files from 

the CD have been installed on your computer.

Using The Writing Trek

1 Make sure the CD is still in the CD or DVD drive.

2 Open the Writing Trek folder on your computer.

3 Double-click The Writing Trek 8-10 I icon to open the program.

Learning More About The Writing Trek

For an introduction to the program, double-click The Guided Tour icon in the 

CD window.

A teacher’s guide is included on The Writing Trek CD. Double-click the Teacher’s

Guide 8-10.pdf icon to open the teacher’s guide.

The Writing Trek also includes an electronic help system. Click the character at the 

top-left corner of most screens to hear more information about the elements of 

that screen.

The service and support telephone number for The Writing Trek is 800-321-7511.
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